Technical Support Guide

Troubleshooting HiQnet Device Discovery
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INTRODUCTION

One of the biggest challenges of working with network devices is getting everything to talk over the
network. In this guide we will cover the troubleshooting steps to take when you are unable to get a computer to



Troubleshooting HiQnet Device Discovery

discover a device. The process for troubleshooting device not discovered involves checking three areas Software,
Network and Device Configuration. Software configuration deals mainly with the software on the PCyou are using.

Network configuration is the physical network including switches and cables and Device Configuration deals with
the firmware andsoftware settings of the actual HiQNet devices.

Software

Configuration
\ eAudio Architect
HiQnet *Windows

wHARMAN Configuration
eThird Party Software

,  Network
Device not : Configuraton
. ] ePhysical Connection
DISCOVEFEd " #7S."  *Switch Configuration

Device Configuration

eDevice Physical
Connection

eDevice IP
eDevice software

The following flow chart breaks down the process intosteps starting with the computer configuration. Each
section of the chartrefers to section of the documentthat explains those steps. When youfirststart
troubleshooting a new systemitis nota badideato startatthe beginningand systematicallywork througheach
section. As youhave more experience you find that you can skip oversections based on knowledge of the system
and usedivideandconquer. Forinstanceyou don’t necessarily need to check all of the firewall and Windows
networking settings if you are missing onlyone device out of 20 and the other devices are seen by Audio Architect.
Most likelyyou wouldwant to skipto the Network and Device configurationand check the device IP to seewhy it
is notshowing up. After each sectionitis recommended thatrefresh the networkinAudio Architect. This way you
arechanging only one thing ata time which will makeiteasier to determinea rootcase.
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Device Discovery- Software and
Computer Configuration-Basic

Connectivity

1.0 Verify Devices 1. Reboot Device
Have Network Link

2.0 Checking Audio
Architect Configuraion

2.1 Is the 2.2 Verify the 2.3 Add the correct adapter
device device IP and under
discovered subnet mask are File>Audio
in in the same range Architect>Application
Netsetter? as the PC Options>Network
adapter. Connectivity.

3.0 Are

multiple HiQnet 3.1 Close multiple instances of Audio 7
programs Architect and refresh the network
running?

a — 3.2 Close London Architect

5.0 Verify 5.1 Make any corrections in the adapter
V;Iindows properties for TCP/IP. Test with ipconfig verify
Networking the IP address using ipconfig

Go to Section 6 Device Discovery - Network and Device

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
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6.0 Device Discovery- Network and
Device

6.1 Connect the computer directly to the device

_ Is device 6.2 Check Network Switch Configuration and
discoverered? Network cables

7.0 Reset Device Network Configuration

7.2 Amplifier 7.3 Contrio Wall Controller

Use London Architect Recessed Recessed
IP Tool Button/Factory Reset Button/Factory Reset

DSP Use London
Architect Configurator
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DEVICE DISCOVERY- SOFTWARE AND COMPUTER CONFIGURATION-BASIC CONNECTIVITY

Device Discovery- Software and
Computer Configuration-Basic
Connectivity

1.0 Verify Devices 1. Reboot Device

1.0 VERIFY DEVICES HAVE NETWORK LINK

Checking the physical connection of the device verifies that the device actuallyhas a network link lightand has a
solid network connection. Amissing link light mayindicatea cableissue or a problem witha switch port. Also itis
easyto pluginthewrong portsince mostdevices have multiple RJ45 connections, make surethedeviceis
connected viathe portlabeled Ethernet.

!

Some devices alsoshow theirlink/networkstatus on the front Panel.

Conductor DI 11Of ; , \
Network link @ : B o
Data activity ’ o 44 Hold

Configured Soundweb Lond as both LEDs.

COM STAT ERR PWR
® & - @

—
ﬁ‘

100 Series Com light shows link and flashes for data activity JJjj
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REBOOT DEVICE (HAVE YOU TRIED TURNING IT ON AND OFF AGAIN?)

In the case of a single device not showing up it is always a good idea to power cycle the device. Also
sometimes if the device is set to a static IP with a gateway that is not reachable by the computer the device

will not be discovered unless it is rebooted. In this case the device will send out a broadcast announce that
should be visible regardless of the IP settings

2.0 CHECKING AUDIO ARCHITECT CONFIGURATION

Audio Architect and Netsetter have their own specific settings to select which network adapters are used.
Netsetter is a tool thatinstalls with Audio Architectand is usedto managethe |P addresses and Network settings
for HiQnet Devices.

2.0 Checking Audio
Architect Configuraion

2.1Is the 2.2 Verify the 2.3 Add the correct adapter

device device IP and under
discovered subnet mask are File>Audio
in in the same range Architect>Application
Netsetter? as the PC Options>Network
adapter. Connectivity.

2.1 ISTHE DEVICE DISCOVERED IN NETSETTER?

Netsetter looks for broadcast UDP packets to discover other HiQNet devices on the same network even if they are
outsidethelP range of the computer. Netsetter hasits own selection for PC adapter which lets you quickly switch
between network adaptersto finda devices that may be connected to different networks. In some cases Netsetter
may notseea device whichmightindicatethe deviceis notconnected on the same VLAN, or somethingin the
Device/Network is preventing the discovery packets from getting to the computer.

2.2 VERIFY DEVICE IP AND SUBNET IS REACHABLE

Ifthe deviceisseen by Netsetter and not Audio ArchitectitcouldbethatthedevicelP addressisoutsidetherange

of the computer’s subnet. In this case the device will be seen in Netsetter but we will notbeableto talk to the
deviceunlesswereaddressit.
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Hidnet MetSetter

192.168.254.35 ~

00-OF-D¢-03-F3-1C - | 10.10.12.16 255.255.255.0 192.168.254.254 62236 | Discovering.. 2= Soundweb London BLU-32604A

PC and F’e"‘ce addresses device shows as discovering
are on different subnets.

2.3 ADD THE CORRECT ADAPTER TO AUDIO ARCHITECT

Audio Architect has its own adapter settings thatareindependent of Netsetter. If you see the devicein Netsetter
butdon’tseeitin Audio Architect then this maybethereason. This may sound simple but manypeopleforgetto
look herefirst. This will actually show youtwo things. First, it will show youwhat adapter the softwareis using.
Second itwill showyou the IP address of the adapter. If no adapters show up when you select add (other thanthe
loop back 127.0.0.1) then you willwant to checkthe status of your connection in Windows. Maybe your wireless

connection dropped or maybethereis another problem preventing Windows from obtainingan|P address suchas
the Network cable or switch port.

fol lication Options .
P P

|'oHce|

-58 DHCP Intel(R) 1211 C ‘twork Connection

fls the correct adapter showing?

Add Connecticn

1

If not then add the connection

Note: We normallyonly recommendhaving one network connection here for simplicity.

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
serve the entertainment and enterprise markets with complete system solutions.

AKG ArMx B dbx i Digllech m lexicon Martin  Soundcraft  sTUDER

crowny o]

Troubleshooting HiQnet D 7



Troubleshooting HiQnet Device Discovery

Onceyou havethecorrectadapter selected, click the refreshbutton which is located under the Add Devices Tab.
You mustbeintheadd devices modeto seethis.

Add Devices

| ‘ ..;" Cut x B IEI‘ W™ Undo Device Mames Rack / Amray Mames
ot (5 copy et W ned HiQnet Addresses [¥] Matched Indicator
Refresh Delete  Select Move i

E Paste All IP Addresses [[] unmatched Indicator

Networkingl] Ciipboard L show I

3.0 MULTIPLE HIQNET APPLICATIONS RUNNING AT THE SAME TIME

3.0 Are

multiple HiQnet . .1 Close multiple instances of Audio
programs > Architect and refresh the network

running?

H _ 3.2 Close London Architect

3.1 CLOSE MULTIPLE INSTANCES OF AUDIO ARCHITECT

If you have morethan oneinstance of AudioArchitect running on the same computer onlyoneinstance willhave
an active network connection. Close multipleinstances and restart the networkingby selecting refresh

Metworking cannot start

| Ancther instance of this application is already running. Networking will not be enabled for this instance.

Ly,
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In some circumstances thisis not obvious because the application canbe minimized to the Windows hidden icons
ifthecurrentuser logged into Audio Architect doesn’t haverights to the application.

The lock indicates
Audio Architect is
running in the
background

Admin -

You can also check the Windows Task Manager (CTRL+SHIFT+ESC) and close the applicationthere as well by
selectingitand choosing End Task.

15l Task Manager = O X
Eile  Options  Wiew
Processes Performance App history Startup Users Details Services
- 25% 35% 0% 2%
Mame | Status | CPU | Memaory | Disk | Metwaork |
> [#E] AMD User Experience Program ... 0% 12ME 0 MB/s 0 Mbps -
ff AMD User Experience Program ... 0.6% 52ME 0 MB/s 0 Mbps
i AMD User Experience Program ... 0% 14MEB 0 MB/s 0 Mbps
»  [#5] Antimalware Service Executable 0.4% 143.2 MB 0.1 MB/= 0 Mbps
[#=] Application Frame Host 0% 21.0MB 0 MB/s 0 Mbps
»  [mE] ASUS Motherboard Fan Control ... 0% 2.6 MB 0 MB/= 0 Mbps
. ASUS Push Motice Server (32 bit) 0% 1.2 MB 0 MB/'s 0 Mbps
> 6 atkexComSvc.exe (32 bit) 1.2% 6.7 MB 0 MB/s 0 Mbps
41 Audio Architect 036 217.2 MB 0 MB/'s 0 Mbps
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3.2 CLOSING LONDON ARCHITECT

If London Architectisrunningatthesametimeitwill grabthe adapter ina similar manner. If you need to run both

applications you will want to select Enable networksharing with System Architectinthe London Architect
Application Preferences. Thiswill allow bothapplications to share the same network adapter.

Application Preferences >
Ewent Log Colovrs Static B outes Inztant Meszaging
eneral Lagaing Start Up File FOS Senal Hillret

Check which interface cards you wizh to uze to configure and control
Hillhet devices. Changes will be applied on 'O

192.168.254.35 [IntellR] 1211 Gigabit Hetwaork Connection]
[]0.0.0.0 [ASUS PCE-M15 11n Wireless LAN PCI-E Card]
[]0.0.0.0 [Micrazaft \Wi-Fi Direct Yirtual Adapter]

[]0.0.0.0 [Microzaoft 'w/i-Fi Direct Witual ddapter #2]

Please choose the name of this comprker
Landon Srchitect GLUI Usge Host M ame

Ilze Pazsive FTP for better compatibility with firessalls

London Architect Prezet Becall method. Change
only if directed to by BSS Technical Support,

Show Hillnet address as hexadecimal
E nable nebwork, sharing with Spstem Architect

Drefault w

[ ] Hide devices on different subnets

kdeter Subscription B ate [in mz]
Fazt Sl

London
Drefault 100ms .

Crawn
Default 200mz .

Cancel Apply Help
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4.0 CHECK FOR ISSUES WITH FIREWALLS OR VPN

Firewallsand VPN’s are designed for network security. Party of whatthey dois block or encapsulateincoming and

outgoingtrafficto prevent hackers from accessing your data. While thisis generally a goodthing, if not configured
correctly itcanandwill interfere with device discovery.

with firewalls or VPN

44 Tumoff
Windows Firewall

4.1 TURN OFF WINDOWS FIREWALL

When in doubtturn off Windows firewall or allow exceptionfor the application.
How Turn off Microsoft Defender Firewall

https://support.microsoft.com/en-us/help/402 8544/Windows-10-turn-microsoft-defender-firewall-on-or-off

Audio Architect will add exceptions to the Windows Firewall for the application when you install the software.

@ HiOnet Sudio Architect
@ HiOnet Listener

@ Hinet MetSetter

Audio Architectinstalls exceptions for the fol lowing:
C:\Program Files\Harman Pro\Audio Architect 2.25\AudioArchitect.exe
C:\Program Files\Harman Pro\Audio Architect 2.25\HiQNetListener.exe

C:\Program Files\Harman Pro\Audio Architect 2.25\HiQNet NetSetter.exe

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
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Troubleshooting HiQnet Device Discovery

When you launch anapplicationyou mightalsosee a promptallowing you to choose to block or unblockthe

application. If you choose to notto unblockthen you will need to manually unblock this in the Windows Firewall
settings.

Private netwaorks, such as my home ar work, nebwork,
Public networks, such as those in airports and coffee shops {not recommended
bercause these netwarks aften have little ar na security)

4.2 TURN OFF ANY THIRD PARTY FIREWALLS.

Thereare many thirdparty firewallson the market. If oneisinstalled it will probablyhaveaniconlocated on the

task bartoindicateits status. Sometimesitisassimpleasright clickingtheiconandchoosing disable. Other times
this willinvolve ITaddingan exception forthe application.

Symantec Endpoint Protection

L T i}
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4.3 DISCONNECT ANY VPN CONNECTIONS

VPN connections encapsulate data overtheinternetto give you a secure connection. Insome cases this can cause

issues with device discoveryifthe VPNis blocking local traffic. If you have a VPN connected try disconnecting the
VPNto seeif the device shows up by refreshing the network.

Note: this applies only when connecting to local devices. When connecting remotelythrough a VPN seethe
HiQNet On ARouted Network Document.

Cisco AnyConnect
VPM: Connected
Rearning Security: Protected by VA

A~ B tm T Q) 214PM

5.0 VERIFY WINDOWS NETWORKING

Sincethe HiQnetsoftwareruns on Windows, itisimportant to verifythe actual networking components of
Windows aresetup correctly.

ndows

Networking the IP address using ipconfig

IPCONFIG
You canstartchecking the status of yourlocal computer connection by using the I pconfig utility. You can run this
by openinga command promptor a PowerShell prompt.

In this casel’musing Windows PowerShell.

In Windows go to searchandtype powershell

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
serve the entertainment and enterprise markets with complete system solutions.
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At the prompttypeipconfig

EN windows PowerShell

Copyright (C) Microsoft Corporation. 811 rights reserwved.

Try the new cross-platform Powershell hitps:ffaka.msfpscoret
PS5 Civlsers® » ipconfig

Windows IP Configuration

Ethernet adapter Ethernet:

Connection-specific DNS Suffix . @ home
Link-local IPvE Address

IPvd Address.

Subnet M 5 o o

Detault Gateway .

Wireless LA&N adapter Wi-Fi:

Media 5tate . . . . . . . . . . . : Media disconnected
Connection-specific DNS Suffix . : home

Wireless LAM adapter Local onnection® 9:

Media State . . . . . . . . . . . ! Media disconnected
Connection-specific DNS Suffix A

Wireless LAM adapter Local Area Connection® 1@:

Media State . . . . . . . . . . . : Media disconnected
Connection-specific DHS Suffi q

Window will reply with the states of my network connections. In thiscasel canseel have oneconnection
connected with anlP address of 192.168.254.35. If your connectionshows media disconnected, then you will
wantto check cabling and the switch.

Also notethatitcantake Windows up to 45 seconds to obtain an IPaddress using Auto IP. Someti mes waiting a
few seconds after plugging somethingin will yieldresults. Onceyou have verified that the Windows connection

has a valid address you can also use PowerShell to ping a deviceif you knowits IP address. If you don't know the IP
address go to step 6.0 Network and Device Settings.

Inthis casel know my BLU806isat 192.168.254.32 so | can try pingingit.

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
serve the entertainment and enterprise markets with complete system solutions.
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PS C:hlsers®

Finging 192.]
Reply from ]
Reply from ]
Reply from ? K
Reply from I time<ims TTL=64

mate round trip times in milli
= @ms, Maximum = @ms, Avera

If the devicereplies back, thatindicates the two devices aretalking and if the deviceis notseen by Audio Architect
thatmightindicate anissue with a Network Firewall suchas port filtering.

USING A WEB BROWSER

You can also verify communication with a device by typingits IPaddressin to a browser this will respond back with
the web page of the device.

[ 192.165.254.32 ¥ | -

< ) O Motsecure | 192.168.254.32 ¥z ¥= @ [ Notymeng 8)
aoundweb

,
\. __ll'
—

Soundweb Londoen is bigger, bolder and more powertful...

Device: BLU326-2

ESS Audic's Soundweb sent ripples around the industry when it was introduced
Building on Soundweb's strengths, Soundweb London is bigger, bolder and more powerful

a llm ks AR raiadlinas imeas ke ar limes Lassd sodes e im0 A ciaals frarmes samfimeablds im0 A anlas o A Gmead

6.0 NETWORK AND DEVICE SETTINGS

Insection6 we will eliminate the networking and cabling as possible causes for a device not being discovered. We
will also resetthe devicelPaddress and network settingsif allelse fails.
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6.0 Device Discovery- Network and
Device

6.1 Connect the computer directly to the device

_ Is device 6.2 Check Network Switch Configuration and
discoverered? Network cables

6.1 CONNECTING DIRECTLY TO THE DEVICE

Connectingdirectlyto the device bypasses the network and helps rule out anything with switch configuration.
Older computers mayrequire a crossover cable when connectingdevices directly together with 100mbit ports.
Most modern computer have gigabit network ports. With a gigabit port, autosensing allows us to pluginto two
devices directly together without a switch and have them auto-negotiate without havingto use a crossover cable.

Onceyou connect your computer directly to a devices Ethernetport giveita minute to auto negotiatean|Pand
then check Netsetter.

6.2 CHECK NETWORK SWITCH CONFIGURATION AND NETWORK CABLES.

If the device shows up when you connect directly, then the connection issueis withthe network cabling or

switch/network configuration. You might wish to test each network cable and try different switch ports. In some
casesrebooting/resetting the switchmay alsohelp.

7.0 RESET DEVICE NETWORK CONFIGURATION

Resetting the device network settings to a known Automatic IP state rules out the device configurationcausing a
problem with discovery. This sectionis divided into three sections. Each section covers the steps for a particular
devicetype.

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
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DSP’s arecovered in7.1 Amps 7.2 and Wall Controllersin 7.3

7.0 Reset Device Network Configuration

7.2 Amplifier 7.3 Contrio Wall Controller

Use London Architect Recessed Recessed
IP Tool Button/Factory Reset Button/Factory Reset

DSP Use London
Architect Configurator

7.1 DSP’S

USE THE LONDON IP TOOL TO RESET THE DEVICE IP ADDRESS.

The London IP Tool allow the user to set the IP address of the device using the MAC address. Thisis useful if you
don’tknowtheIP address of thedevice or the deviceis outside the range of the PCand is not visiblein Netsetter
or London Architect. Setthe deviceto automaticlP or assignita staticIPinthesamerangeasyourcomputer and
press send. If the unitshows up after rebootyou canthen readdressit. Ifthe unitdoesn’tshow up or the MAC
address sticker has been removed you will need to use the London Configurator to check/set the IP address.

For Moreinfo see Using the London Architect IPTool

USING THE LONDON CONFIGURATOR.

The London Configurator talks to the DSP via the serial connection. Thisis useful if youneed to pull the IP address
orifthe Ethernet portis not workingyou can reset the portsettings. To use this tool you will need a serial portand
a femaleto female nullmodemcable.
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_
-

=T - R - L
W om o~ B W N =

DB-9 female-to-female null modem cable

You can getto the London Configurator through London Architect

Help>Run Utility.

Help |

| Help Topics

Important Cobranet Information...
Read Me...

E) About..

Test 8
Write System Information...
| Run Utility..

Check for Updates

Select London Configurator and run.

Fun Utility >

Select the utility From the list below and
then press 'Run...' to run Ehe ukiliky

Book Loader

London Confiqurator
IP Settings
DI Message

HARMAN Professional Solutions is the world's largest professional audio, video, lighting and control products and technologies company. We
serve the entertainment and enterprise markets with complete system solutions.
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You alsofind the Configuratorinthe in the London Architect Folder andlaunch itthis sinceitis standalone
application.

Onceyou open theapplication youwill need to select your com port. You should see connected to com port. If
youseecomalreadyinuse makesureto closeany other applications using the com port

. London Configurator >

Select COM port

COML o Refresh

Connected ta COM port

Send to § Fead from Device Read device

1P Address MAC Address
(0.0 . 0. 0] | |

Subnet Mask Firmware Wersion
(0.0 .0 0] | |

Gateway
o .0 .0 .0 |

Jauta 1P

Mode netwaork address (hex)

[ ]

Device Mame

Pork Status

Clrre CIHTTPR

[relnet [ Jraw Msg

Send
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Also makesurethecom portis NOT checked inthe London Architect application preferences since this will create
a conflict.

Selectrefresh should pull theinformationfrom the DSP.

London Configurator @

Select COM port

[ comt v ] l Refresh ]
Connected to COM port
Send to [ Read from Device Read device

IP Address MAC Address

| 169 . 254 . 22 . 41 | | D0:0F:D4:00:1E:56 |
Subnet Mask Firmware Version

[ 255 .25 . 0 . 0 | 13.0.0 |
Gateway

|o.0.0.0J

[Jauto 1P

Mode network address (hex)

E

Device Name
’ BLL-500 |

Port Status
[VIFTP [“]HTTP
Telnet Raw Msg [

Send ]

Check the Auto IP button and select Send. This will cause the device to reboot. If not power cycle the box. This
should reinitialize the network communication.

7.2 AMPLIFIER

ITECH HD/DCI/MAI
To perform the Factory Reset procedure:
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Warning! All user presets willbe permanentlydel eted and allsettings reverted back to their factorydefa ult state.
This process is irreversible. If you have any user presets you wish to keep, they should be backed up using Audio
Architect before performing the FactoryReset.

To restore factory default settings: Press the Reset Button with a thin, non-conductive object, then turn on
amplifier power, and continue to hold the reset button until the Preset light comes
on green (approximately 16 seconds).."

CDI AMPLIFIER

To perform the Factory Reset procedure:

Warning! All user presets willbe permanentlydeleted and all settings reverted back to their factory default state.
This process is irreversible. If you have any user presets you wish to keep, they should be backed up using Audio
Architect before performing the FactoryReset.

1 Power off the amplifier by pressing and holding the Power button for2 seconds.

2 Press andhold the CH1 and CH2 SELECT buttons while powering on the amp. Continue to hold these buttons
until the LCD reads: "Press MENU to restore Factory Settings or any other buttonto exit". Now release the
SELECT buttons.

3 Press andreleasethe MENU button to start the FactoryReset procedure (pressing any other button willabort
the Factory Reset procedureandthe amp will boot up normally).

4 OncetheFactory Reset procedure begins, the LCD will display the message: "Restoring factory defaults!" and
when complete, the device will boot up normally.
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7.3 CONTRIO WALL CONTROLLER

To restore factory default settings: Unplug the wall control. Press the recessed button on the front with a
thin, non-conductive object and then plug in the wall controller. The Front panel will display an option to
factory reset the wall controller. Pressing the Factory Reset button will reset the device IP address and the
device configuration. If using an EC-V, the controller will reset automatically when the recessed located
button is held during boot up.

EC4, EC4BV, EC8BV reset menu.

Reboot
(o]
Q Reset
o) Factory
| [O
r ‘,: . ‘...,:::—‘ [ ‘f'_.\ | -
S5
R ——
Netw ork Status-
© Firmee are version
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